
Getting Started
with Office XP

As we manage our business and personal worlds,
we continually need to accomplish more, faster,

and better. Microsoft Office XP provides you the
tools to do all this and more. Each of its programs—
Word, Excel, PowerPoint, Access, Outlook, Publisher,
and Internet Explorer—has a special function, yet
they all work together so you can combine word 
processing, spreadsheets, presentations, databases,
scheduling, publications, and Internet communica-
tion. The results are professional, dynamic, and 
effective documents for every occasion. Every Office
program uses the same structure of windows,
menus, toolbars, and dialog boxes, so you can focus
on creating the best document rather than struggling
with how each program works. Office programs
have personalized menus and toolbars that display
only the commands and toolbar buttons you use
most frequently, which saves space and increases
your efficiency. In addition, you can perform your
most basic actions the same way in every program.
For example, in each Office program, you open, save,
and close documents with the same buttons or com-
mands. When you have a question, the identical help
feature is available throughout Office programs.
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Starting an Office Program
The quickest way to start an Office program is from the Start menu on the

taskbar. Office lets you customize your work area and switch from program to

program with the click of a button.

NOTE You can get Office information on the Web from within any Office program. Click the Help
menu, and then click Office On The Web. Your Web browser opens, displaying the Microsoft
Office Update Web site.

Start an Office Program from the Start Menu
1. Click the Start button on the taskbar.

2. Point to Programs. 

3. Click the Office XP program that you want to open.

Chapter 1 • Getting Started with Office XP
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TIP You can start an Office program and open a document from Windows Explorer. Double-click
any Office document icon in Windows Explorer to open that file in its associated program.

Start an Office Program and 
Open a New Office Document

1. Click the Start button on the taskbar, and then click New

Office Document. The New Office Document dialog box opens.

2. Click the tab for the type of document you want to create.

3. Click a document icon, and then click the OK button to start the 

program and open a new document.

Opening an Existing File
Before you can begin working, you need to open a document. You can open

the file (and its program) at one time, or you can start the program and then

open the file from within the program. 

TIP You can reopen a recently closed file by clicking the filename at the bottom of the File menu.

Opening an Existing File
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NOTE You can quickly open a copy of a file.When you open a file from the Open dialog box, click the
Open button drop-down arrow, and then click Open As Copy. The Office program creates a
new copy of the file in the same folder with the filename Copy of [Filename].

Open an Existing File from the Start Menu
1. Click the Start button on the taskbar, and then click Open

Office Document.

2. Click an icon on the Places bar to open a frequently used folder.

3. If necessary, click the Look In drop-down arrow , and then click the

drive where the file is located.

4. Double-click the folder in which the file is stored.

5. Double-click a filename to start the program and open the file.

Open an Existing File from Within an Office Program 

1. Click the Open button on the Standard toolbar.

2. Click an icon on the Places bar to open a frequently used folder.

Places bar

Chapter 1 • Getting Started with Office XP
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3. If necessary, click the Look In drop-down arrow , and then click

the drive where the file is located.

4. Double-click the folder in which the file is stored.

5. Double-click the file you want to open.

NOTE You can delete or rename any closed file from the Open or Save As dialog box. Click the file,
click the Tools drop-down arrow, and then click Delete or Rename.

Saving a File
Frequently saving your files ensures that you don’t lose work during an unex-

pected power loss. The first time you save a file, specify a filename and folder

in the Save As dialog box. The next time you save the file, Office saves it with

the same name in the same folder. If you want to change a file’s name or loca-

tion, you can use the Save As dialog box to create a copy of the original file. 

TIP What’s the difference between the Save and Save As commands? The Save command saves a
copy of your current document to a previously specified name and location.The Save As com-
mand creates a copy of your current document with a new name, location, or type.

Saving a File
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NOTE When you name a file, you do not have to type the filename extension. Each Office program
automatically adds the correct filename extension to files.

Save a File for the First Time

1. Click the Save button on the Standard toolbar.

2. Click an icon on the Places bar to open a frequently used folder.

3. If necessary, click the Save In drop-down arrow , and then click the

drive where you want to save the file.

4. Double-click the folder in which you want to save the file.

5. Type a name for the file, or use the suggested name that appears in the

File Name box.

6. Click the Save button.

TIP To modify your default save settings, choose Tools ➢ Options, click the Save tab, click the
options you want, and then click the OK button.

Chapter 1 • Getting Started with Office XP
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Save a File with Another Name
1. Click the File menu, and then the Save As command (File ➢ Save As).

The Save As dialog box opens

2. Click an icon on the Places bar or click the Save In drop-down 

arrow , and then click the drive or folder where you want to save

the file.

3. Type a new filename in the File Name box. 

4. Click the Save button.

TIP To save all your files at one time, hold down the Shift key, and then choose File ➢ Save All.

NOTE A file type specifies the document format (for example, a template) as well as the program
and version in which the file was created (for example, Excel 2002). You might want to
change the type to an earlier version if you’re not certain that your recipient has the same
version of a program.

Saving a File
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Choosing Menu and Dialog Box Options
A menu is a list of related commands. For example, the Edit menu contains

commands for editing a document, such as Delete and Cut. A shortcut menu

opens when you right-click a word or object while you’re working and con-

tains commands related to a specific object. Clicking a menu command fol-

lowed by an ellipsis (...) opens a dialog box, which is where you choose various

options and provide information for completing the command. As you switch

between programs, you’ll find that all Office menus and dialog boxes look simi-

lar and work in the same way.

TIP When you first open a menu, the commands you used most recently appear first. Point to the
Toolbar Options drop-down arrow to display the full menu.

Choose Menu Commands
1. Click a menu name on the menu bar, or right-click an object (such as a

toolbar, spreadsheet cell, picture, or selected text).

2. If necessary, click the double arrow to expand the menu and display

more commands.

3. Click a menu command you want, or point to the arrow to the right of

the menu command to display a submenu of related commands, and

then click the command you want.

Chapter 1 • Getting Started with Office XP

Menu
A list of associated commands
or options, located beneath the
title bar (at the top of the win-
dow).You can choose a com-
mand or option by pointing to
it and the clicking the mouse,
or by highlighting it, and then
pressing the Enter key on the
keyboard.

Shortcut menu
A menu that lists commands
when you right-click a word or
object.To customize shortcut
commands, choose Tools ➢
Customize ➢ Toolbars.

Dialog box
A window that displays
onscreen that you use to enter
or select information.
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TIP Toolbar buttons and shortcut keys are faster than menu commands.You can learn the toolbar
button equivalent of a menu command by using the toolbar button icon to the left of a menu
command. Keyboard shortcuts appear to the right of their menu commands. To use a key-
board shortcut, hold down the first key (such as Ctrl), press the second key (such as V), and
then release both keys (such as Ctrl+V).

NOTE The most common dialog box buttons are the OK button, which confirms your selections and
closes the dialog box; and the Cancel button, which closes the dialog box without accepting
your selections.

Choose Dialog Box Options
All Office dialog boxes contain the same types of options, including the 

following:

Tabs. Click a tab to display its options. Each tab groups a related set of

options.

Option buttons. Click an option button to select it. You can usually

select only one.

Spin box. Click the up or down arrow to increase or decrease the

number, or type a number in the box.

Check box. Click the box to turn the option on or off. A checked box

means the option is selected; a cleared box means it’s not.

List box. Click the drop-down arrow to display a list of options, and

then click the option you want.

Text box. Click in the box and type the requested information.

Button. Click a button to perform a specific action or command. A

button name followed by an ellipsis (...) opens another dialog box.

Preview box. Many dialog boxes display an image that reflects the

options you select.

Choosing Menu and Dialog Box Options
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Spin box

ButtonText box

Option button Check box
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Working with Toolbars
Each Office toolbar contains a collection of buttons that you click to select fre-

quently used menu commands. Most programs open by placing the Standard

toolbar (which contains commands such as Save and Print) and the Formatting

toolbar (which contains commands for selecting fonts and sizes) side by side.

You can also display toolbars designed for specific tasks, such as drawing pic-

tures, importing data, or creating charts. The Office program you’re in will per-

sonalize the toolbars as you work, showing only the buttons you use most

often. Additional toolbar buttons are available by clicking the Toolbar Options

drop-down arrow at the end of the toolbar.

Display and Hide a Toolbar
1. Right-click any visible toolbar.

2. Click the name of the toolbar you want to display or hide.

Working with Toolbars

Toolbar
A collection of buttons that
represent tools and that have
equivalent commands on a
related menu.
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Move and Reshape a Toolbar
You can modify the look of a toolbar in any Office program.

· To move a toolbar that is docked (attached) or floating (unattached)
over the window, click the gray bar on the left edge of the toolbar, and
then drag it to a new location. 

· To return a floating toolbar to its previous docked location, double-
click its title bar.

· To change the shape of a floating toolbar, drag any border until the
toolbar is the shape you want.

TIP When you first open a toolbar, the buttons you used most recently display. Click the Toolbar
Options drop-down arrow to display any other toolbar buttons. To display the full toolbar,
double-click the gray bar on the left edge of the toolbar.

Display Toolbar Options on a Toolbar
To display more buttons on a toolbar, click the Toolbar Options drop-down

arrow at the right end of the toolbar.

Docked toolbar Floating toolbar

Chapter 1 • Getting Started with Office XP

Docked
A toolbar that is attached to
one edge of the window.

Floating
A toolbar that has a visible title
bar and that you can move.
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Arranging Windows
Every Office program and document open inside a window, which contains all

the program commands and is where you create and edit your documents.

Most often, you’ll probably fill the entire screen with one window. Other times,

when you may want to move or copy information between programs or docu-

ments, it’s easier to display several windows at once. You can arrange simulta-

neously on the screen two or more windows from one program or from

different programs. However, you must make the window active before you

can work in it. You can also click the document buttons on the taskbar to

switch between open Office documents.  

Resize and Move a Window
All windows contain the same sizing buttons:

Maximize button. Click to make a window fill the entire screen.

Restore button. Click to reduce a maximized window to approximately

half its full size.

Minimize button. Click to shrink a window to a taskbar button. To restore

the window to its previous size, click the appropriate taskbar button.

Close button. Click to shut a window.

Restore button

Minimize button

Close buttonMaximize button

Title bar

Arranging Windows

Window
An onscreen box that contains
a title bar, menus, toolbars, and
a work area.
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You can move a window to any location on the screen by clicking its title bar

and dragging the window to a new location. Release the mouse button when

the window is where you want it. 

TIP You can use shortcut keys to open and close windows, and quickly switch between windows.
To close the active window, hold down the Ctrl+W keys on the keyboard. To switch to the
next window, hold down the Ctrl+F6 keys on the keyboard, and to switch to the previous
window, hold down the Ctrl+Shift+F6 keys on the keyboard.

TIP Only one window can be active at a time.You can tell whether a window is active by the color
of its title bar. By default, an active window’s title bar is blue and the inactive title bar is gray.
To make an inactive window active, click anywhere in the window.

Switch Between Document Windows
Each open Windows file or document displays its own button on the Windows

taskbar. You can click the buttons on the taskbar to switch between open files.

Choosing Templates and Wizards
Office makes it easy to create many common documents based on a template

or using a wizard. A template opens a document (such as a letter) with prede-

fined formatting and placeholder text that specifies what information you

should enter (such as your name or address). A wizard walks you through the

steps to create a finished document tailored to your preferences. The wizard

asks you for information, and then, when you click the Finish button, it creates

a completely formatted document based on the options and content you

entered. You use a template to add information to a designed document, and

you use a wizard to add a design to information you supply. 

Chapter 1 • Getting Started with Office XP

Template
A file that defines the styles,
fields, formatting, and layout of
a document.

Wizard
A utility that leads you through
steps to produce a product or
accomplish a task.
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Choose a Template
1. Click the Start button on the taskbar, and then click New

Office Document, or choose File ➢ New. The New Office Document

dialog box opens.

2. Click the tab for the type of document you want to create.

3. Click the template you want to use. 

4. Check the Preview box so you verify that the template will create the

right style of document.

5. Click the OK button.

6. Type text for placeholders such as [Click here and type your letter text].

TIP If you create a Word document using a wizard,Word bases the document on the Normal doc-
ument template. However, the styles Word uses in the document reflect the formatting
options that you select when responding to the wizard.

Choosing Templates and Wizards
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Choose and Navigate a Wizard
1. Click the Start button on the taskbar, and then click New

Office Document, or choose File ➢ New. The New Office Document

dialog box opens.

2. Click the tab for the type of document you want to create. 

3. Double-click the icon for the wizard you want to use.

4. Read and select options (if necessary) in the first wizard dialog box.

5. Click the Next button to progress to the next wizard dialog box. Each
wizard dialog box asks for different information.

6. Continue to select options, and then click the Next button.

7. When you reach the last wizard dialog box, click the Finish button.

Chapter 1 • Getting Started with Office XP
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Getting Help in an Office Program
At some point, you will have a question or two about the program you’re using.

The Office online Help system provides the answers you need. ScreenTips show

toolbar names and short descriptions about anything you see on the screen 

or in a dialog box. If you need help while you work, you can use the Ask a

Question box to quickly get help. You can also search an extensive catalog of

Help topics by an index or a table of contents to locate specific information. 

Get a ScreenTip
1. Place the mouse pointer over a toolbar button. The name of the button,

or the ScreenTip, appears below the button.

NOTE To hide ScreenTips, choose Tools ➢ Customize ➢ Options, click the Show ScreenTips On
Toolbars check box to clear it, and then click the OK button.

Get Help While You Work
1. Click the Ask a Question box on the menu bar,

type a question, press the Enter key, and then click a topic.

Getting Help from the Office Assistant
Often the easiest way to learn how to accomplish a task is to ask someone who

knows. Now, with Office, that knowledgeable friend is always available in the

form of the Office Assistant. Tell the Office Assistant what you want to do in

the same everyday language you use to ask a colleague or friend, and the

Office Assistant walks you through the process step by step. If the personality

of the default Office Assistant—Clippit—doesn’t appeal to you, you can choose

from a variety of other Office Assistants.

Getting Help from the Office Assistant

ScreenTips
Descriptive text that displays
when you hold the mouse
pointer over a button.
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TIP You can open the Office Assistant by clicking the Help button. If the Office Assistant is already
turned on, you will see the Office Assistant at the top of your screen. If the Office Assistant is
turned off, the Help pane appears where you can get search for help by topic.

Ask the Office Assistant for Help

1. Click the Help button on the Standard toolbar, or click the Office

Assistant to turn on the Office Assistant.

2. Type your question about a task with which you want help.

3. Click the Search button.

4. Click the topic in which you’re interested.

5. Read and follow the directions. After you’re done, click the Close

button on the Help window.

6. Click the Help button on the Standard toolbar to hide the Office 

Assistant.

NOTE Get useful tips from the Office Assistant. When a light bulb appears above the Office
Assistant, click the Office Assistant to see a tip for a simpler or more efficient way to accom-
plish a task.

Chapter 1 • Getting Started with Office XP
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Choose an Office Assistant
1. Right-click the Office Assistant and click Options, or click the

Options button in the Office Assistant window. The Office Assistant

dialog box opens.

2. Click the Gallery tab.

3. Click the Next button and the Back button to preview different Office

Assistants.

4. Display the Office Assistant that you want to use.

5. Click the OK button. If the Office program prompts you to insert the

Office XP CD-ROM in your drive, insert the CD-ROM, and then click

the OK button.

Turn Off the Office Assistant
1. Right-click the Office Assistant and click Options, or click the

Options button in the Assistant window.

2. Click the Options tab.

3. Click the Use Office Assistant check box to clear it.

Getting Help from the Office Assistant
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4. Click the OK button.

Displaying the Office Shortcut Bar
The Office Shortcut Bar provides quick access to all the programs on your

computer. You can display one or more toolbars and customize buttons on the

Office Shortcut Bar. The Office Shortcut Bar itself can be floating, not attached

to any part of your screen, or docked, attached to the left, right, or top edge of

your screen. 

1. Click the Start button , point to Programs, point to

Microsoft Office Tools, click Microsoft Office Shortcut Bar.

2. Install the component if necessary.

3. Click Yes to start the Office Shortcut Bar automatically whenever 

Windows is started.

TIP To customize the Office Shortcut Bar, right-click anywhere on the Office Shortcut Bar (except
the title bar), click Customize, click the Buttons tab, click to select or clear the buttons you
want to show or hide on the toolbar, and then click the OK button.

Chapter 1 • Getting Started with Office XP
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Close the Office Shortcut Bar
1. Click the Office icon on the title bar.

2. Click Exit.

3. If prompted, click the Yes or No buttons to instruct Windows to 

display the Office Shortcut Bar the next time you open Windows.

Closing a File
To conserve your computer’s resources, close the files and programs that you

are not currently working in. You can close open documents one at a time, or

you can use one command to close all open files without closing the program.

Either way, if you try to close a document without saving your final changes, a

dialog box appears, prompting you to do so.

TIP When two or more documents are open in a program, the document window contains one
Close button. The Close button closes the document without exiting the program. You might
need to click a Word document button on the taskbar to make it active before you click the
Close button.

Close One File
1. Click the Close button on the title bar in the upper-right corner.

2. If necessary, click the Yes button to save your changes.

Close a File
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Quitting an Office Program
When you decide to stop working for the day, before you shut down your com-

puter, you must quit any running programs. All open documents close when

you quit. If you haven’t saved your final changes, a dialog box appears,

prompting you to do so.

TIP Access automatically compresses a database when you close the file. Choose Tools ➢ Options
➢ General tab, click the Compact On Close check box to select, and then click the OK button.

Quit an Office Program
1. Click the Close button , or choose File ➢ Exit.

2. If necessary, click the Yes button to save any changes you made to

your open documents before the program quits.

Chapter 1 • Getting Started with Office XP
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